
Adobe Photoshop CC  
(2014 version) update

Welcome to the latest Adobe Photoshop CC bulletin update. 
This is provided free to ensure everyone can be kept up-
to-date with the latest changes that have taken place in 
Photoshop CC. 
	 This bulletin describes the latest changes to the main 
Photoshop program. For a complete description of how to 
use these new Photoshop tools, with diagrams and step-by-
step tools, I recommend you buy the Adobe Photoshop CC 
for Photographers book.
	 The 2014 version of Photoshop CC contains some 
significant new features, such as Color Lookup table exports, 
Focus Area selections, enhanced Content-Aware filling plus 
new Spin and Path blur gallery effects.
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Minimum operating system requirements (Mac)
With this new major release of Photoshop the minimum 
operating system specifications for Macintosh users means 
that this version of Photoshop (and all other programs within 
the Creative Cloud) are only able to run on Mac OS X 10.7 and 
higher. Those who are running Mac OS X 10.6 will still be able 
to use their current applications, but will need to upgrade if 
they wish to install this newest version of Photoshop.

Flash support
Adobe are discontinuing support for Flash, which is now being 
removed from dialogs and panels. This has resulted in the 
removal of Mini Bridge, Kuler and Adobe Exchange.

Font Search
You can now use the Font Search feature in Photoshop to 
locate installed fonts. For example, if you want to find a font 
that belongs to the ‘Times’ family, you just type in ‘times’ and 
the fonts matching that search will be revealed in a drop-down 
list, as shown in Figure 1 below. You can also carry out searches 
to find fonts that are ‘italic’, or ‘bold’. You can also combine 
search criteria. So for example, if you type ‘t bold italic’, this will 
shortlist those fonts with a ‘T’ in the name and which are also 
available in bold italic.

Figure 1  The Character panel showing the results of a font search for ‘Times’ fonts.
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Windows screen resolution support 
Following the introduction of Mac OSX Retina support, the 
Photoshop interface has now undergone a significant number 
of changes in order to support higher resolution screens on the 
Windows OS. These changes to the layout design of many of 
the dialogs affect the traditional 1X scaling, as well as the more 
dense displays (also known as 2X or HiRes).
	 Some user interface elements, such as Camera Raw, Liquify 
and Adaptive Wide Angle remain unchanged, but most other 
dialogs including all the adjustments and filters have been 
revised in this latest version. The layouts are different, as are 
the pull-down menus and buttons. Some have changed from 
being vertical to horizontal in layout, such as Curves, Shadow/
Highlight and Color Settings (see Figure 3). This has been 
necessary in order to ensure these will fit more universally on 
any screen display.
	 The font size is now consistent between the Mac and 
Windows platforms. If you go to the Interface preferences 
(Figure 2) you’ll see the following font size options: Tiny (9pt), 
Small (10pt), Medium (11pt) and Large (12pt). 9pt is new for the 
Windows platform and 10pt is new for the Mac.

Figure 2  The Photoshop Interface preferences, showing the new UI Font Size menu 
options.
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Figure 3  This shows a comparison between the Photoshop Curves panel in 
Photoshop CC v14.2 (top) and v.15 (bottom).

Minimum display size
The minimum display size for Photoshop 
has been revised from 1024 x 768 pixels to 
1080p @ x2 pixel density. In other words 
a computer display with a pixel density of 
1920 x 1080 pixels at a x2 density. This 
effectively now means a display resolution 
of 960 x 540 pixels is the new minimum 
size. This has presented a problem for 
the Photoshop user interface whereby 
existing dialogs now have to fit within 
tighter constraints so that when a 1920 
x 1080 display is set to function at a x2 
pixel density, the Photoshop user interface 
elements can all now fit within this. For 
the most part is has meant making some 
of the traditional Photoshop dialogs more 
widescreen. While the dialog design 
changes here may not suit everyone it 
has to be pointed out that applying direct 
adjustments (such as with the Curves 
dialog) is the old way of doing things. 
It is more appropriate to use adjustment 
layers, where the Properties panel layout is 
adaptable and less intrusive.
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Color Lookup Table Export
The Color Lookup feature was first introduced to Photoshop 
CS6 and offered a way to package a lot of complicated 
adjustments into a single adjustment. It can use ICC profiles 
(Abstract and Device link), or the less standardized 3D LUT 
formats (which are widely used in the film and video industry). 
Added to this now is the ability to generate your own Color 
Lookup tables via Photoshop for use in Photoshop, After 
Effects, and other image/video editing applications.
	 To use, open an image, add some adjustment layers to 
give the image the desired look and then go to the File menu 
and choose Export ➯ Color Lookup Tables... (Figure 4). The 
dialog will prompt you to give the Lookup table a name plus 
an optional copyright string: i.e. “(©) Copyright YEAR”followed 
by your custom text. Selecting more grid points will result in 
bigger tables, but higher quality. In the export dialog you can 
save the look using the 3DL, CUBE, CSP or ICC profile formats 
(the first three are all 3D LUT formats).
	 To export as a Color Lookup table the image you work must 
contain a Background layer plus additional layers to modify 
the colors. This can include the use of color filled pixel layers, 
gradients and patterns incorporating the use of conditional 
blending. However, for best results try using adjustment layers 
only to create the desired coloring effect, as the use of pixel 
layers may give unexpected results in the final exported Color 
Lookup table.

Figure 4  The Export Color Lookup Tables dialog.

Tips for generating lookup tables
If you start with an image in Lab color 
mode, the Export Color Lookup Tables 
command will allow you to save an 
Abstract ICC profile, which is the most 
useful kind for coloring work. If you start 
out with a document in RGB mode only 
3DLUT and RGB device link formats can 
be saved.
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1 I processed this photograph in Photoshop by starting out with the image in Lab 
color mode and adding a couple of adjustment layers: a Hue Saturation layer to 
desaturate the color combined with a Color Balance adjustment to alter the color. I 
then saved the image, went to the File menu and chose Export Color tables, checking 
the ICC profile option (see Figure 4). 

2 I then opened another image in Photoshop (this time in RGB mode), added a Color 
Lookup adjustment layer and loaded the color lookup table I had just exported as an 
Abstract Device profile. In this example, I reduced the adjustment layer opacity to 50%.
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Figure 5 Here is a photograph of a turkey photographed using a long focus lens, 
where the background was out of focus. In Photoshop I chose Select ➯ Focus Area… 
to open the dialog shown here with the default In-Focus Range Auto option.

Focus area
The Focus Area feature can be used as a selection tool to 
make selections based on focus. It is basically another tool 
in the retoucher’s arsenal that can be used to make speedy 
selections. For example, the quick select tool can be useful to 
make quick selections based on color difference. This tool that’s 
in the Select menu can ne used to make selections based on 
sharpness and is useful for cutting out objects shot against an 
out-of-focus background.
	 When creating a selection you have the option of overriding 
the Auto option and manually adjusting the In-Focus Range 
slider (Figure 5). This can help refine the selection. You can also 
click on the add and subtract tools to add to or remove from a 
focus area selection (just like you would when working with the 
quick select tool).
	 The Focus Area selection will always have a hard edge 
though, which you can resolve by checking the Soften Edge 
option, or by clicking the Refine Edge… button to open the 
Refine Edge dialog where you can fine-tune the edges of the 
selection as desired.

Before After
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Tips when working with Focus Area
If the selection needs improvement it is best to override the 
Auto option and adjust the In-Focus Range slider. If the In-
Focus Range selection happens to include a lot of the out-
of-focus background area this could be because the Focus 
Area selection is picking up noise. If this happens expand 
the Advanced options, set the Noise to manual and gradually 
increase the Noise slider to see if this clears up the selection 
area. Basically, with higher ISO images you will need to 
increase the slider setting. However, sometimes when the 
Noise slider is set high, everything will be selected. So it is best 
to make small careful adjustments and if it’s not looking right 
check the Auto option to reset to auto mode again. 

Enhanced content-aware
Content-aware processing has been improved in this current 
release. There has been an overall improvement in terms of 
quality and speed. For example, content-aware is now around 
10 times faster when working on really large repair areas and 
around 4 times faster when editing smaller images.

Enhanced content-aware color adaptation
In the Fill dialog there is now a Color Adaptation checkbox, 
while in the Options bar Adaptation menu for the patch tool 
and content-aware move tool there is also a Color setting. A 
zero setting means no color tolerance occurs (just as before). 
As you increase this value more color blending occurs up to 
a maximum blend setting of 10 (an example of this is shown 
over the page). The Content-aware algorithm generally has a 
preference for smoothness over texture. Increasing the color 
tolerance further improves the smoothness and this method of 
filling and repairing is mainly useful when working on smooth 
graduated areas. A Color Tolerance setting of 10 will tend to 
over compensate, so the best setting options are within the 
3–7 range.
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1 To demonstrate the power of the new Color Tolerance controls, I used the content-
aware move tool to move the cloud selection in this photograph. 

2 In this example the Adaptation Structure was set to the default 5 setting with zero 
Color tolerance. This is matches the legacy setting for this tool. Notice how the moved 
selection shows poor blending around the selection edges.
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3 I then redid the last step, but this time set the Color setting to 10. However, this over 
compensated with the cloud selection blending. 

4 Here, I used the content-aware move with a Color setting of 4 to produce a much 
smoother-looking result.
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New Motion Blurs for Blur Gallery
There are now two new blur effects added to the Blur Gallery: 
Spin Blur and Path Blur. These allow you to apply circular spin 
blur or camera motion blur type effects. Both can be accessed 
by going to the Filter ➯ Blur menu. 

Spin blur
When the Spin Blur effect is selected you can apply a spin blur 
in varying intensity. This filter effect you can produce is similar 
to the Radial Blur filter in Spin mode, except when applied here 
as a Blur Gallery filter you have a lot more interactive control 
over the final effect. For example, you can apply an elliptical 
shaped blur, recenter the blur effect and adjust the Blur angle 
(see Figure 6) while being able to see a live preview.
	 You can adjust the Spin blur by dragging the Blur Angle 
slider to increase or decrease the strength of the effect (or click 
and drag clockwise or anti-clockwise on the blur ring). You can 
then drag the handles to change the Spin blur size and shape, 
plus drag the feather handles to adjust the feathering. You can 
reposition by click dragging anywhere inside the ellipse area 
and further spin blurs can be added by clicking anywhere else 
in the image area and you can also have them overlap.
	 The rotation center point can be adjusted by A dragging 
the blur ring. This allows you to create spin blurs on objects that 
are viewed from an angle. To copy a Spin Blur, click inside a Blur 
ring, hold down the C key (Mac) L key (PC) and then the 
A key and with both keys held down drag to copy to a new 
location within the image. To hide the blur ring go to the View 
menu and deselect ‘Extras’, or use the Ch (Mac) Lh (PC) 
shortcut. 

Figure 6  The Spin Blur controls in the 
Blur Tools panel.
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1 I created this image by taking a photograph of a 4x4 vehicle that was shot in a town, 
cut it out and placed as a layer above a photograph shot in a deserted landscape.

2 I converted the cut out image into a Smart Object and double-clicked to open in 
Photoshop as a separate document. I then carried out a number of edits and converted 
the Background layer to a Smart Object ready to apply a Spin Blur filter effect to the 
wheels.
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3 I then went to the Filter menu and chose Blur ➯ Spin Blur… I dragged the Spin 
Blur ellipse over to the front wheel and manipulated the shape so that the Spin Blur 
ellipse matched the shape of the tire. I then applied a 35° Blur Angle via the Blur Tools 
panel Spin Blur section.

4 I held down the C key (Mac) L key (PC) and then the A key and clicked 
on the Blur ring center and dragged to create a duplicate of the first Spin Blur effect. 
I dragged to locate this second Spin Blur effect over the rear wheel. Once done, I 
checked the High Quality option in the Options bar and clicked the OK button. This 
applied the Spin Blur effect as an editable Smart Filter to the 4x4 layer.
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Path blur
The Path Blur tool can be used to create a motion blur effect 
along a user-drawn path. Basically, by adjusting the path shape 
you can manipulate the shape and direction of the motion blur 
to create an effect similar to camera shake, such as when 
photographing a moving subject and the camera shutter is left 
open for a long exposure time. You can manipulate the curve 
shape to control the length and curvature of the Path Blur, click 
on the path to add more control points and click on existing 
curve points and drag to further modify the shape. A -click 
on a Path Blur control point to convert it to a corner point, or 
convert a corner point back to a smooth point.
	 The path blur shape will have red blur direction arrows at 
either end point. You can click on a path blur shape end point, 
or a blur direction arrow and click and drag to determine the 
blur direction (the End Point Speed) and adjust the angle. The 

5 Lastly, I chose File Save to save the edited Smart Object layer and closed the Smart 
Object document window. The original image with the 4x4 plus landscape was now 
updated to show the vehicle with wheels that appeared to be in motion.
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blur directional arrows also have a midpoint control you can 
click on and drag to further alter the shape of the blur direction. 
To disable an end point blur direction arrow, hold down the C 
key (Mac) L key (PC) and hover over a path blur end point, 
you’ll see a filled circle appear next to the cursor. Click on the 
end point to disable. Hold down the C key [Mac] L key 
[PC] and click again to enable. If you hold down the S key 
you can click and drag a blur direction arrow at one end and 
simultaneously move the arrow at the other end as well.
	 It helps to understand here that the defined blur shapes 
at the two ends of a path are interpolated between the two 
end-points. Also, as you add more path blur shapes to an image 
these will influence each other and it is this aspect of the Path 
Blur filter that provides lots of opportunities to produce creative 
blurring effects. To add a new path blur keep clicking to add 
more control points and press E or ‰ to end the path blur 
shape, or just click on the last control point. To reposition a path 
blur, hold down the C key (Mac) L key (PC) and click on the 
blue path or a control point and drag to relocate. To remove a 
control point, select a path blur control point and hit the D 

key. To duplicate a Path blur, hold down CA (Mac) LA 
(PC) as you drag a blue path or one of the control points.
	 The overall blur strength can be controlled by adjusting the 
Speed slider in the Path Blur section of the Blur Tools panel 
(Figure 7). There are two starting point modes here: Basic 
Blur and Rear Sync Flash (examples of which are shown over 
the page). The Taper slider can be used to dampen the path 
blur effect and adjust the edge fading from either end. The 
Centered Blur checkbox governs the way the blur shapes are 
calculated. This box is checked by default to ensure the blur 
shape for any pixel is centered on that pixel. This produces 
a more controlled behavior when editing path blur shapes. 
When it’s unchecked the image it will sample from one side of 
any pixel only and will flow around a lot more as you edit the 
path blur shapes. As I just mentioned, the End Point Speed 
slider is linked to the length of the blur direction arrows, and 
the Edit Blur Shapes box allows you to view/hide the blur 
direction arrows. In the Options bar is a High Quality checkbox 
(Figure 8). Check this to produce high quality rendering to 
prevent any jagginess appearing in a path blur effect.

Figure 7  The Path Blur controls in the 
Blur Tools panel.

Figure 8  The Blur Tools Options bar.
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Smart Guides
Smart Guide behavior has been enhanced in this version. The 
preferences settings remain the same. Smart Guides are now 
enabled by default and you will notice how reference guides 
appear that call out the distance between the current selected 
object and a referenced object (see Figure 9). This distance 
is calculated based on the distance between the object 
bounding box rectangles, rather than measuring between the 
text baselines, or individual path points of a vector shape. As 
you move an object, Measurement Guides visually indicate 
the spacing between the selected object and its immediate 
neighbors. To disable Smart Guides go to the View menu, 
select Show ➯ Smart Guides and check to turn off.

Smart Guides modifier key behavior
If you hold down the A key as you drag to duplicate a 
layer or text layer using the move tool, or duplicate a vector 
shape using one of the path selection tools the reference 
measurement guides will show the distance between the 
duplicate object and the original (see Figures 10 & 11).
	 If you select a layer and hold down the C key (Mac) 
L key (PC) as you hover the cursor over another layer this 
will show the Measurement Guides. You can then use the 
keyboard arrow keys to nudge the selected layer as you do this 
(see Figures 12 & 13).

Figure 9  If you rely on Smart Guides to 
measure the distance between two objects it 
is calculated based on the distance between 
the object and the bounding box object. In 
this case it will be the distance measured 
between the outer bounds of the text 
bounding boxes.

Figure 10  In this example, I held down the A key as I dragged the selected 
Layer 1 layer. This made a duplicate of the layer and a Smart Guide appeared to 
indicate the distance apart for this and the original layer.
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Figure 12  In this example I held down the C key (Mac) L key (PC) as I 
hovered the cursor over the image. The Smart Guides in this instance indicate the 
distances relative to the current selected object. Here it indicates the distances relative 
to the document bounds. If I rolled over one of the other layers it would indicate the 
distances relative to the selected object.

Figure 11  In this example I created a vector shape layer and held down the A 

key as I dragged to create a duplicate of the shape. The Smart Guide indicated the 
distance moved from the original by the duplicate.

Figure 13  In this example I had duplicated a vector shape and held down the C 
key (Mac) L key (PC) as I hovered the cursor over the image. This indicated the 
gap distance between the bounding boxes of the two objects.’.
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Matched Spacing
When you move an object, such as a layer, Measurement 
Guides will visually indicate the spacing between this layer and 
other layers where the spacing matches. These Measurement 
Guides will suddenly pop up as you move the layer (or other 
object) just within range of the same measured distance as the 
other objects (see Figure 14 below).

Figure 14  As you move an object closely within range of a similar measured 
distance to two or more other objects, you will see matched spacing Measurement 
Guides appear as shown here.
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Sync Settings
The Sync Settings mechanism has been simplified. If you are 
subscribed to the Adobe Creative Cloud, your account will 
only allow you to activate Photoshop on two machines. Using 
the Sync Settings feature you can help keep your settings 
synchronized between those two active computers, which can 
be done manually from each machine to the user’s Creative 
Cloud account. Note, when using multiple Adobe IDs you can 
synchronize settings separately to each account.
	 Figure 15 shows the Sync Settings preferences. This will 
show the Adobe ID you are currently signed in to and contains 
Upload and Download buttons you can use to sync settings. 
By default all settings (Everything) are synchronized. If you click 
on the pop-up menu in the Advanced Settings you can choose 
Custom and select specific settings to synchronize. Note that 
in addition to the items shown here, an Adobe Photoshop CC 
Prefs.psp file is synchronized automatically via the Creative 
Cloud. Note also these options do not include items specific 
to the machine running the application, such as scratch disk 
usage and memory allocation. 

Figure 15  The Photoshop Interface preferences, showing the new Sync Settings.
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	 When you click either the Upload or Download command 
buttons, this initiates the synchronization process. You will 
see a progress bar at the top of the Sync Settings and a log 
report appear in the Log window below. Alternatively, you 
can go to the Photoshop ➯ Adobe ID submenu and choose 
‘Upload Settings’, or ‘Download Settings’. These commands 
are also based on the settings configured in the Sync Settings 
preferences and will bring up a modal progress dialog (see 
Figure x).
	 Upload takes all the non-factory settings files (ie. user 
modified settings) and uploads them to your Adobe ID Creative 
Cloud account. Files that have the same names are overwritten 
and there is no conflict resolution. Download takes all the 
settings files on the server and downloads them to your 
computer. Any files that have the same names are overwritten. 
Again, there is no conflict resolution.
	 Basically, the intention here has been to clarify the 
synchronization process and remove the confusion caused 
from having a single ‘Sync’ button and understanding the 
‘When Conflicts Occur’ menu options that were present in the 
original Photoshop CC.

Workspace synchronization support
Workspaces, including those with keyboard 
shortcuts and menu customization are now 
supported in Sync Settings. However, this 
support is limited to single platforms only 
– there is no cross platform support.

Figure 16  This shows the Photoshop ➯ Adobe ID submenu. Selecting either 
Upload Settings, or Download Settings will bring up the modal progress bar shown 
here.
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Smart Objects: creating a package file
Smart Objects can be added as embedded, or as linked Smart 
Objects. To help users share files that contain Linked Smart 
Objects and make them portable, there is now a Package… 
command available from the File menu. When you have an 
image open that contains Linked Smart Objects, this allows you 
to save a copy of the master to a packaged folder containing 
the master image plus a folder that contains the linked Smart 
Object files. To avoid redundancy, where there are multiple 
instances of Linked Smart Objects pointing to the same source 
file the Package operation only creates one copy of the Linked 
Smart Object source image.

Figure 17  This shows an image that contains Linked Smart Object layers. When 
using the File ➯ Package… command, this creates a folder containing a copy of the 
master image plus a Links folder containing the Linked Smart Object layers.

Package command limitations
The Package command currently packages 
image asset files only. It does not yet 
include other assets such as fonts.


